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1 Welcome to Kindle Previewer 

Kindle Previewer is a free downloadable viewer that enables your computer to emulate how a broad 

range of Kindle devices and apps will display your book. Kindle Previewer makes it easy for publishers to 

preview e-book layouts, see how their text will look on specific Kindle devices, and adjust display 

orientation, font sizes, paragraph styles, and editorial conventions accordingly.  

Kindle Previewer is designed to help authors, publishers, and e-book converters produce the highest-

quality Kindle books. You can navigate through an e-book quickly and easily, turning the pages one by 

one to confirm that your book is ready to be published to the Kindle Store, and downloaded to Kindle 

devices. Use Kindle Previewer independently, or as a companion to the KindleGen book-building tool. 

1.1 Specifications 

Kindle Devices Emulated 

Kindle Previewer can display e-books as they will appear on these Kindle devices: 

• Kindle Fire HD  

• Kindle Fire HDX  

• Kindle Fire HDX 8.9"  

• Kindle Paperwhite  

• Kindle DX  

• Kindle for iPhone (Kindle Reading App) 

• Kindle for iPad (Kindle Reading App) 

Supported File Formats 

Kindle Previewer can display e-books created in the following formats: 

• .mobi 

• .epub 

• .azw 

• .html 

• .opf 

• .prc 

• .zip (XMDF) 

http://www.amazon.com/kindleformat/kindlepreviewer
http://www.amazon.com/kindleformat/kindlegen
http://www.amazon.com/kindleformat/kindlepreviewer
http://www.amazon.com/dp/B00CU0NSCU
http://www.amazon.com/gp/product/B00DOPNO4M/ref=fs_j
http://www.amazon.com/gp/product/B00DOPNLJ0/ref=fs_ta
http://www.amazon.com/gp/help/customer/display.html/ref=hp_200953940_pw_landing?nodeId=200953940
http://www.amazon.com/gp/help/customer/display.html/ref=hp_200127470_dx?ie=UTF8&nodeId=200375440
http://www.amazon.com/gp/feature.html/ref=kcp_iph_ln_ar?docId=1000301301
http://www.amazon.com/gp/kindle/kcp
http://www.amazon.com/gp/feature.html/ref=kcp_ipa_ln_ar?docId=1000490441
http://www.amazon.com/gp/kindle/kcp
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1.2 System Requirements 

Hardware requirements 

Kindle Previewer requires that your computer and monitor meet these minimum requirements: 

• 1GHz processor 

• 512 MB of RAM 

• 15-inch display size 

• 1024 by 768 screen resolution 

Operating systems 

Kindle Previewer is compatible with the following operating systems: 

• Windows® 7 

• Windows® XP (SP3 or later) 

• Windows® Vista (SP2 or later) 

• MacOS® X (10.6 or later) 

NOTE:  Your Macintosh computer must have an Intel processor. 

1.3 Installing Kindle Previewer 

1.3.1 Downloading Installers 

• Kindle Previewer  
The Kindle Previewer home page provides Windows® and MacOS® installers. 

• KDP Tools and Resources  
Provides Windows® and MacOS® installers for Kindle Previewer, Kindle Comic Creator, Kindle 
Plugin for Adobe InDesign®, KindleGen (also Linux), and Kindle Reader. 

1.3.2 Installing on Windows® Systems 

To install Kindle Previewer on a Windows® system, do the following: 

1. Download the Kindle Previewer installer to your computer. 

2. Double-click the KindlePreviewerInstall.exe file to launch the installer.  

3. Select a language for the installer, then click OK. 

4. Review the Software End User License Agreement, then click I Agree. 

5. Select the installation folder.  

The default paths for installing Kindle Previewer on a PC are: 

Windows® 7, and Windows® Vista: 

C:\Users\[user]\AppData\Local\Amazon\Kindle Previewer  

http://www.amazon.com/kindleformat/kindlepreviewer
https://kdp.amazon.com/self-publishing/help?topicId=A3IWA2TQYMZ5J6
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Windows® XP: 

C:\Documents and Settings\[user]\Local Settings\Application 

Data\Amazon\Kindle Previewer  

To install Kindle Previewer in different location on your computer, click Browse and select 
the target folder. 

6. Wait a moment for the installation to complete. 

You can now launch Kindle Previewer. 

1.3.3 Installing on MacOS® Systems 

To install Kindle Previewer on a MacOS® system, do the following: 

1. Download the Kindle Previewer installer to your desktop. 

2. Extract the Kindle Previewer application file from the .zip archive. 

3. Drag the Kindle Previewer application file to your Applications folder. 

You can now launch Kindle Previewer. 
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2 Using Kindle Previewer 

2.1 Launching Kindle Previewer 

• If you set Kindle Previewer as your computer’s default application for opening Kindle books, 
you can double-click on any Kindle book to display it in Kindle Previewer.   

• Otherwise, right-click any Kindle book, select Open With, and choose Kindle Previewer. 

• Or send a Kindle Previewer shortcut to your desktop, then drag your book file and drop it 
onto that shortcut. 

• Or launch Kindle Previewer from Start  All Programs  Amazon  Kindle Previewer, set a 
Default Device Mode, and click the Open Book link or select File  Open Book. 

• Or launch a book in Kindle Previewer from the Command prompt (see section 3.3, Command 
Prompt Launch).  

2.2 Welcome Page Settings 

The default settings on the “Welcome” page preconfigure Kindle Previewer to emulate a family of Kindle 

devices, set the Previewer screen to Portrait or Landscape orientation, and display its menus and 

toolbars in your language of choice.  

Default Language 

Select a language from the drop-down list for Kindle Previewer’s menus and toolbars. The 

choices include English, French, German, Italian, Spanish, Portuguese, Chinese, and Japanese.  

Default Orientation 

Select whether Kindle Previewer will open an e-book for viewing in Portrait (longer sides vertical) 

or Landscape (longer sides horizontal) orientation.  

NOTE:  This default setting will be overridden if an e-book’s metadata locks Orientation. 

Default Device Mode 

Select a Kindle device or app from this drop-down list of Kindle families for Kindle Previewer to 

emulate. The choices include Kindle Fire HD, Kindle Fire HDX, Kindle Fire HDX 8.9”, Kindle 

Paperwhite, Kindle DX, Kindle for iPhone, and Kindle for iPad. 
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2.3 Device Bar 

The Device Bar located just beneath the Toolbar offers choices from the family of Kindle devices that 

Kindle Previewer is currently emulating. 

To reset the Device Mode of Kindle Previewer so that it emulates another Kindle device or app: 

• Click any member of this Kindle family listed in the Device Bar. 

[or] 

• Press the TAB key or SHIFT + TAB to toggle through the current Device Bar choices. 

[or] 

• Click Home in the Taskbar, then reset the Device Mode to another Kindle family. 

TIPS:  On setting the Device Mode: 

• When Device Mode is set to the Kindle Fire device family, Kindle Previewer can 
display fixed-layout children’s books, comics, and graphic novels. 

• When Device Mode is set to “Kindle for iPhone” or “Kindle for iPad,” you can click 
to play video or audio clips in a Kindle Enhanced Edition or Audible Audio Edition. 
See “Transcode” in section 2.5.5, Utilities Menu. 

2.4 Toolbar 

Use the Kindle Previewer Toolbar to navigate through your current e-book and adjust display options. 

Back 

 
Returns to the page displayed before the last page change. 

Home 

 
Returns to the “Welcome” page of Kindle Previewer. 

Previous Section 

 
Jumps back to the start of the previous section or chapter. 

Next Section 

 
Jumps ahead to the start of the next section or chapter. 

Previous Page 

 
Displays the previous page. 

Next Page 

 
Displays the next page. 
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Rotate Screen 

 

Turns the orientation to Portrait (long sides vertical) or Landscape (long sides horizontal).  
Enabled for e-books whose metadata settings do not lock the book’s reading orientation. 

Set Font 

 
Selects from the text font faces and sizes available on the Kindle device.  
Enabled for e-books with flowing text. 

Zoom In 

 

Enlarges the size of the current page.  
Enabled for  fixed-layout books in “Kindle Paperwhite” Device Mode.  

Zoom Out 

 

Reduces the size of the current page.  
Enabled for fixed-layout books in “Kindle Paperwhite” Device Mode. 

Zoom Fit 

 

Switches in one click from a zoomed view to the default view of the current page.  
Enabled for fixed-layout books in “Kindle Paperwhite” Device Mode.  

Scale Down 

 

Reduces the size of the current page from large to medium to small.  
Enabled when Device Mode is set to “Kindle Paperwhite” or “Kindle Fire.” 

Scale Up 

 

Enlarges the size of the current page from small to medium to large.  
Enabled when Device Mode is set to “Kindle Paperwhite” or “Kindle Fire.” 

Cover 

 

Displays the cover page of the current e-book. 

Table of Contents 

 

Displays the Table of Contents for the current e-book.  
Enabled when a book has a Table of Contents. Kindle devices do not support TOCs for books 
with fixed-layouts (such as children’s books).  

NCX View 

 

Displays the logical Table of Contents for the current e-book. An NCX view is often available 
even if a book does not have a physical TOC. See section 2.5.2, View Menu. 
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2.4.1 Resizing Content 

Kindle Previewer’s controls to scale pages, fonts, and panels are enabled or disabled by particular 

combinations of book format (fixed-layout or flowing-text) and Kindle device (e-ink, Fire HD, or iOS). 

• Click the Scale Up button on the Toolbar to enlarge a page, or Scale Down to reduce it. There 
are three size options for the two buttons, small, medium, and large. 

• In “Paperwhite” Device Mode, click the Zoom In button on the Toolbar to enlarge page 
content, or Zoom Out to reduce it. These buttons offer six size options. 

• When reading a flowing-text book with the Devices menu set to the “Kindle Fire HD” family, 
click the Set Font button on the Toolbar to change Font Sizes, choosing from ten sizes.  

• When a fixed-layout book includes Kindle Panels, virtual panels, or text popups, double-click 
to “tap” them and expand their content. Then press the Right Arrow key ( or ) to “tap” 
the next panel or popup, or the Left Arrow key ( or ) to ”tap” the previous one.  

NOTE:  An e-book’s Pane Magnification Level setting will override Kindle Previewer. 
The default zoom setting for Kindle panels in Kindle Comic Creator is 150%. 

2.5 Menus 

You can access most functions of Kindle Previewer from the menus above the Toolbar. 

2.5.1 File Menu 

Use the File menu to open and close books, and to exit the Kindle Previewer application. 

Open Book 

Opens e-book files in Kindle-compatible formats: .mobi,. epub, .azw, .prc, .opf, .zip(XMDF) or 

.html. You can also drag such book files and drop them onto Kindle Previewer to display them. 

NOTE:  You cannot open encrypted books in Kindle Previewer. 

Close Book 

Closes the current e-book. 

Open Recent 

Displays a list of recently opened e-books. Select Clear List to remove all items from this list. 

Exit 

Closes the current e-book and exits the Kindle Previewer application. 

http://www.amazon.com/kindleformat/kc2
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2.5.2 View Menu 

Use the View menu to display your e-book’s metadata and logical structure. 

Book Information 

Displays the metadata defined for the current e-book, including Language, Title, Author, Cover 

Page, File Format, Book type, and Table of Contents or .NCX file. 

NCX View 

Opens a logical Table of Contents for the current e-book, as defined in its navigation control 
(.NCX) file. Double-click any link in NCX View to jump to the selected location. 

TIP:  Readers can use the NCX view to track their progress through a book. For guidance on 
implementing .NCX files, download the Amazon Kindle Publishing Guidelines (PDF). 

2.5.3 Go to Menu 

Use the Go to menu to navigate to specific locations in the current e-book.  

Home 

Jumps to the “Welcome” page of Kindle Previewer.   

Location 

Jumps by number to a page in the current e-book. 

TIP:  Without opening the Go to Location dialog box: 

• To display the number of the current page, enter CTRL+U. 

• To jump to the first page in the book, enter CTRL+SHIFT+F. 

End 

Jumps to the last page in the current e-book. 

Table of Contents  

Jumps to the current e-book’s Table of Contents. 

NOTE:  Enabled when a book has a Table of Contents. Kindle devices do not support TOCs 
in e-books with fixed-layouts (such as children’s books and graphic novels). 

Next Page 

Displays the next page in the current e-book. 

Prev Page 

Displays the previous page in the current e-book. 

http://kindlegen.s3.amazonaws.com/AmazonKindlePublishingGuidelines.pdf
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Beginning 

Jumps to the "Start reading" location in the current book, as defined in the book's manifest (.opf) 

file. Typically this is the first page of the e-book’s first chapter. 

Cover 

Displays the cover page of the current e-book. 

Auto Flip 

Use Auto Flip to display the pages of the current e-book as a slide show, flipping from start to 

finish or finish to start. To adjust the Auto Flip Speed, drag the slider to the desired setting. 

NOTES:  On Windows® XP systems, don’t let a screen saver interrupt Auto-Flip. On 
MacOS® systems, don’t run Auto Flip while multiple instances of Kindle Previewer are 
open. See section 3.7.2, Known Issues for Kindle Previewer.  

Optional Locations 

The Go to menu also lists locations defined in the current e-book, such as these:  

Start Reading 

Returns to the starting point for readers marked in the e-book. 

Prev Image 

Jumps to the image before the selection point.  

NOTE:  Enabled in e-books with flowing text and images. 

Next image 

Jumps to the image after the selection point.  

NOTE:  Enabled in e-books with flowing text and images. 

Search Word 

Enter a search string to find in the current book.  Enabled in e-books with flowing text. 

TIP:  If you wish, you can choose to view the Search Word results as a list. 
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2.5.4 Devices Menu 

From the Devices menu, you can reset the Device Mode of Kindle Previewer so that it emulates a range 

of Kindle devices and  apps grouped by technology. 

Kindle e-ink 

Displays the current book as it will appear on Kindle Paperwhite or Kindle DX devices. 

Kindle Fire 

Displays the current book as it will appear on Kindle Fire HD, Fire HDX, or Fire HDX 8.9” devices. 

Kindle for iOS 

When you select "Kindle for iOS," Kindle Previewer converts your book to .azk format.  

You can then sideload this .azk book file onto your iOS device, and read the book using its “Kindle 

for iPhone” or “Kindle for iPad” app. For sideloading procedures, see section 2.5.4.1, Sideloading 

onto iOS Devices. 

Kindle Previewer will not convert book with audio/video into .azk, instead those books can be 

previewed inline in Kindle Previewer. Please see “Transcode” in section 2.5.5, Utilities Menu for 

more information. 

TIP:  Selecting "Kindle for iOS" also enables Kindle Previewer to play video and audio clips. 
(Kindle Enhanced Editions with video or audio clips are not converted to .azk format.) 
For transcoding settings, see section 2.5.5.1, Transcoding Video Files to iOS Format. 

2.5.4.1 Sideloading onto iOS Devices 

To sideload a converted .azk book file onto your iPhone or iPad, do the following: 

1. Open a book file for preview, then set Kindle Previewer’s Devices menu to “Kindle for iOS.” 

2. Kindle Previewer converts the book file to .azk format for iOS.  

NOTE:  If you have set Kindle Previewer’s Default Device Mode to “Kindle for iPhone” 
or “Kindle for iPad,” then whenever you open a book file for preview, your book 
file will be converted to .azk format. 

3. The Converting Book dialog opens. Where the dialog says “The output file has been 
generated here,” click the “here” link. This opens the folder on your computer where your 
.azk book file is stored. 

4. Connect your iPhone or iPad to your computer. 

5. Launch iTunes on your computer. In iTunes, click Apps and select Kindle Apps. 

6. Drag the converted .azk file from its folder and drop it onto the iTunes Kindle Documents area. 

[or] 

Click Add in iTunes to select the converted .azk book file and add it to Kindle Documents. 

http://www.amazon.com/gp/feature.html/ref=kcp_iph_ln_ar?docId=1000301301
http://www.amazon.com/gp/feature.html/ref=kcp_iph_ln_ar?docId=1000301301
http://www.amazon.com/gp/feature.html/ref=kcp_ipa_ln_ar?docId=1000490441
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7. You can now read the book on your iPhone or iPad. Launch the Kindle app on your iOS 
device, and look in Device Mode under Books or All Items. 

NOTE:  For help with iTunes®, see the Apple Web site. 
If the Kindle app on your iOS device does not yet list your .azk book file, then: 

a. Close the Kindle app on your iOS device. 

b. Copy the .azk book file to your iOS device (as described above). 

c. Restart the Kindle app on your iOS device. 

2.5.5 Utilities Menu 

From the Utilities menu, you can reset the language of the Kindle Previewer interface, opt in or 

out of the Kindle Previewer data collection program, and adjust the transcoding of audio and 

video clips. 

Language 

Choose Language from the Utilities menu to reset the language of the Kindle Previewer 

interface. 

Usage Data Collection 

Select this option to opt in or opt out of the Kindle Previewer data collection program. 

NOTE:  Enabling this option helps Amazon to understand and fix any issues you may 
encounter with Kindle Previewer. No personal information is ever gathered, and the 
technical data that is collected is used only by the Kindle Previewer team. 

Transcode 

This submenu is enabled when you open a book in Kindle Previewer that includes audio or video 

clips. For more information, see section 2.5.5.1, Transcoding Video Files to iOS Format.  
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2.5.5.1 Transcoding Video Files to iOS Format 

Set the Devices Menu to “Kindle for iOS” to preview Kindle Enhanced Editions and other e-books 

with video or audio clips (these are not converted to .azk format). This process uses your 

Transcode settings on the Utilities menu.  

Set FFmpeg Path 

Kindle Previewer uses the FFmpeg transcoder to convert the video clips. Enter the full local 

path to your FFmpeg executable file in this field.  

TIP:  The FFmpeg transcoder for Windows® and MacOS® can be downloaded from: 
http://ffmpeg.org/download.html  

Transcode Status 

Tracks the transcoding process for each of the video clips in the current book. 

Transcode Automatically 

When this option is enabled, as you open a Kindle Edition or Audible Audio Edition, Kindle 

Previewer searches the e-book for video clips, and runs FFmpeg in the background to 

transcode all of the clips at once, so that they are all ready to play.  

When this option is disabled, transcoding is done item by item, as you click each clip to play it. 

TIP:   By default, when you left-click an audio or video clip, Kindle Previewer plays the 
clip converted to iOS specifications. You can also right-click to launch the source 
(original) media file for the clip in the player of your choice, without transcoding. 

http://ffmpeg.org/download.html
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2.5.6 Help Menu 

From the Help menu, you can open this User Guide, display lists of all keyboard shortcuts, download the 

Amazon Kindle Publishing Guidelines, send feedback e-mail to the Kindle Previewer team, set update 

options and check for updates, and display your version of Kindle Previewer. 

Kindle Previewer Help 

Displays this Kindle Previewer User Guide. 

Keyboard Shortcuts 

Displays a list of all keyboard shortcuts. For printable lists, see section 3.2, Keyboard Shortcuts. 

Open Kindle Publishing Guidelines 

Downloads the Amazon Kindle Publishing Guidelines  as a .PDF file. Follow these Guidelines to 

create the source files for Kindle e-books, and to publish Kindle e-books to the Amazon site. 

Send Feedback 

Sends e-mail to the Kindle Previewer team. Your feedback, questions, and comments are 

welcome. The message generated helps the team to understand the state of the product. 

Update Options 

Opens the Update Options dialog box, where you can choose what to do when a new version of 

Kindle Previewer becomes available. 

Check for Updates 

Select Check for Updates to download and install the current version of Kindle Previewer. 

About Kindle Previewer 

Displays the version of Kindle Previewer that you have installed. 

http://kindlegen.s3.amazonaws.com/AmazonKindlePublishingGuidelines.pdf
http://kindlegen.s3.amazonaws.com/AmazonKindlePublishingGuidelines.pdf
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3 Appendix 

3.1 Glossary 

Orientation 

How the display screen of Kindle Previewer is turned, to Portrait view (longer sides vertical) or 

Landscape view (longer sides horizontal). See sections 2.3, Device Bar and 2.4, Toolbar. 

Device Mode 

Selects a family of Kindle devices or apps for Kindle Previewer to emulate. See sections 2.3, 

Device Bar and 2.5.4, Devices Menu. 

Tap 

To click on a Kindle panel, which magnifies its content. One of three ways for Kindle Previewer to 

enlarge e-book content. See section 2.4.1, Resizing Content.  

NCX View 

A logical Table of Contents for the current e-book, as defined in its navigation control (.NCX) file. 
See section 2.5.2, View Menu. 

Transcode 

Convert audio and video clips to iPhone / iPad specifications. When Device Mode is set to “Kindle 
for iPhone” or “Kindle for iPad,” and you open a Kindle Edition or Audible Audio Edition with 
audio or video clips, Kindle Previewer runs the FFmpeg transcoder to convert the clips to iOS 
format. See sections 2.5.5, Utilities Menu and 2.5.4, Devices Menu. 

Sideload 

Copy a converted .azk book file to your iPhone or iPad device, for viewing there with that 
device’s “Kindle for iPhone” or “Kindle for iPad” app. See section 2.5.4.1, Sideloading onto iOS 
Devices. 

KindleGen 

The KindleGen utility is a free tool that converts e-books to Kindle .mobi format. KindleGen runs 
from the Windows® Command window or the MacOS® Terminal window. See Appendix section 
3.5, Using KindleGen to Build Kindle e-Books. 

http://ffmpeg.org/download.html
http://www.amazon.com/gp/feature.html/ref=kcp_iph_ln_ar?docId=1000301301
http://www.amazon.com/gp/feature.html/ref=kcp_ipa_ln_ar?docId=1000490441
http://www.amazon.com/kindleformat/kindlegen
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3.2 Keyboard Shortcuts 

Windows® MacOS® X Task 

↑ ↑ Scroll Page up 

↓ ↓ Scroll Page down 

→ → Go to Next Page 

← ← Go to Previous Page 

CTRL + → CMD + → Go to Next Section 

CTRL + ← CMD + ← Go to Previous Section 

CTRL + L CMD + L Go to Location 

CTRL + B CMD + B Go Back 

CTRL + S CMD + S Go to Beginning 

CTRL + T CMD + T Go to Table of Contents 

CTRL + R CMD + R Go to Cover 

CTRL + SHIFT + F CMD + SHIFT + F Go to First Page 

F3 Fn + F3 Go to Previous Image 

F4 Fn + F4 Go to Next Image 

F5 Fn + F5 Zoom Out 

F6 Fn + F6 Zoom In 

CTRL + N CMD + N NCX View 
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Windows® MacOS® X Task 

CTRL + K CMD + K Display Keyboard Shortcuts 

CTRL + F CMD + F Find 

CTRL + O CMD + O Open Book 

CTRL + W CMD + W Close Book 

CTRL + U CMD + U Copy page number 

CTRL + SHIFT + A CMD + SHIFT + A Auto Flip 

CTRL + SHIFT + T CMD + SHIFT + T Transcode Status 

CTRL + X CMD + Q Exit 

CTRL + SHIFT + R CMD + SHIFT + R Rotate Orientation 

CTRL + ↑ / ↓ CMD + ↑ / ↓ Set Font Size 

3.3 Command Prompt Launch 

Kindle Previewer for Windows® now supports command line arguments. If you have Administrator 

rights, you can open an e-book in Kindle Previewer directly from the command prompt. 

1. Open the Command window from the Start menu. 

TIP:  To open the Command window as an Administrator who can launch programs there: 

a. Expand the Start menu, and type command in the Search programs and files field. 
The “Command Prompt“ shortcut appears. 

b. Right-click to display this shortcut’s Properties. 

c. Click Advanced, and select Run as Administrator. 

d. Then click OK and OK again to close Properties. 

Whenever you click the “Command Prompt” shortcut, it will now open the Command 
window with Administrator permissions. 

2. At the command prompt, type KindlePreviewer.exe and a following space, then press 
CTRL + Click to Paste in a path to an e-book on your computer. For example: 

KindlePreviewer.exe C:\Users\[user]\My Documents\Books\Book1.mobi 

3. Press Enter. Kindle Previewer opens and displays the book named.  
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3.4 Customer Support 

3.4.1 Updates 

• From the Help menu, select Check for Updates to get the current version of Kindle Previewer. 

• Select Update Options to open the Update Options dialog box, where you can choose what 
to do when new versions of Kindle Previewer become available. 

3.4.2 Kindle Publishing Tools 

The Amazon  Kindle Publishing Tools group makes ongoing improvements to all Kindle apps, including:  

• Kindle Previewer 

• Kindle Comic Creator 

• Kindle Plugin for Adobe InDesign® 

• KindleGen 

We encourage you to join in the discussions on the Kindle Publishing forum. You can also e-mail us at: 

kindle-publishing-tools@amazon.com  

3.4.3 Kindle Publishing Guidelines 

The Amazon Kindle Publishing Guidelines provide guidance on how to format and test e-books, and 

suggest best practices for Kindle publishing. To download this .PDF file, click the following link: 

• Amazon Kindle Publishing Guidelines (PDF) 

3.5 Using KindleGen to Build Kindle e-Books 

You can use Kindle Previewer to assist you while running the KindleGen utility to convert e-books to 

Kindle format. KindleGen is a free command-line tool that build Kindle e-books from source files in 

HTML, XHTML, or IDPF 2.0 format (HTML content files with an XML .opf manifest file). KindleGen is the 

only tool officially supported by Amazon to convert these files into Kindle .mobi format. 

TIP:  You can download installers for Windows® and MacOS® from the KindleGen site.  

When you open an e-book in .epub format in Kindle Previewer, KindleGen converts the book to Kindle 

.mobi format. When this conversion is done, the Compiling eBook dialog box displays the resulting 

KindleGen build messages. Click OK and Kindle Previewer displays the converted e-book. 

NOTES:  KindleGen is designed to run from the Command (PC) or Terminal (Mac) window. 
Double-clicking KindleGen will not launch it. 

 If you drag a source file and drop it onto the KindleGen application, KindleGen will convert 
the file to Kindle format, but it will not log any compilation messages.  

http://www.amazon.com/kindleformat/kindlepreviewer
http://www.amazon.com/kindleformat/kc2
http://www.amazon.com/kindleformat/kindlepluginforadobeindesign
http://www.amazon.com/kindleformat/kindlegen
http://www.amazon.com/forum/kindle%20publishing?_encoding=UTF8&cdForum=Fx21HB0U7MPK8XI
mailto:kindle-publishing-tools@amazon.com?subject=Query%20re%20Kindle%20Previewer
http://kindlegen.s3.amazonaws.com/AmazonKindlePublishingGuidelines.pdf
http://www.amazon.com/kindleformat/kindlepreviewer
http://www.amazon.com/kindleformat/kindlegen
http://www.amazon.com/kindleformat/kindlegen
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3.5.1 KindleGen for Windows® 

KindleGen will run on Windows® 7, Windows® XP, and Windows® Vista. 

1. Download the KindleGen installer archive to your computer. 

2. Right-click the installer archive, select Extract All, and extract the KindleGen application files 
to a convenient folder, such as c:\KindleGen.  

3. Select Start  Run, type cmd and press Enter to open the Command window. 

4. For guidance on how to run KindleGen in the Command window, type kindlegen at the 
command prompt and press Enter. 

3.5.1.1 Book Conversion Example for Windows® 

Suppose that you wish to convert a source file called MyBook.html to Kindle format. You’ve stored this 

file in your \My Documents\Books\ folder. 

1. Copy the full path to your \Books folder from folder Properties.  

2. Open the Command window. At the command prompt, type cd (“Change Directory”) and a 
following space. 

3. Then press CTRL + Right-Click to paste in the path to your \Books folder. For example: 

cd C:\Users\[user]\My Documents\Books 

Then press Enter. The command prompt changes to indicate the new directory. 

4. At the command prompt, type an instruction to KindleGen such as this one, giving the full 
path to the KindleGen application, then a space, then the name of your source file: 

c:\KindleGen\kindlegen MyBook.html 

5. Press Enter. If KindleGen is able to convert your source file, it creates a new Kindle book file 
called MyBook.mobi in your \Books subfolder.  

3.5.2 KindleGen for MacOS® 

KindleGen will run on MacOS® X 10.5 and above, on Macintosh computers with Intel processors. 

1. Download the KindleGen archive to your computer. 
By default, the file is placed in your Downloads folder.  

2. Double-click the downloaded archive to extract the KindleGen application.  

NOTE:  The Safari Web browser extracts the KindleGen application automatically. 
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3. Click the spotlight icon in the top right corner and type Terminal.  
Then click to open the Terminal window. 

4. In the Finder window, go to the Downloads folder and select the KindleGen application. 

5. Drag the KindleGen application from the Downloads folder and drop it on the Terminal 
window at the cursor location. The full path to KindleGen is typed automatically, and the 
cursor shifts to the end of the current line.  

6. Press Enter for guidance on how to run KindleGen in the Terminal window.  

[or]  

Type a “Change Directory” command like this one and press Enter: 

cd ~/Downloads/KindleGen_Mac_i386_v2 

Then type kindlegen at the terminal prompt and press Enter again for KindleGen help. 

3.5.2.1 Book Conversion Example for MacOS® 

Suppose that you wish to convert a source file called MyBook.html to Kindle format. You’ve dragged 

this file to your Macintosh desktop. 

1. Open the Terminal window. At the terminal prompt, type kindlegen with a following space. 

2. Drag your source file to the Terminal window and drop it at the cursor location. The path to 
your file is added automatically, and the cursor shifts to the end of the line.  

kindlegen ~/Desktop/MyBook.html 

Then press Enter.  

[or] 

In the Terminal window, type a “Change Directory” command like this one, and press Enter: 

cd ~/Downloads/KindleGen_Mac_i386_v2 

3. The terminal prompt changes to indicate the new folder. Then type an instruction like this 
one to KindleGen, and press Enter again: 

kindlegen ~/Desktop/MyBook.html 

4. If KindleGen is able to convert your source file, it creates a new Kindle book file called 
MyBook.mobi on your Macintosh desktop. 
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3.6 Online Resources 

Various Kindle Web sites can help you install Kindle Previewer and other Kindle Tools, and use them to 

convert e-books to Kindle format and publish them to your Kindle device.  

TIP:  CTRL+Click any link to open the site in a new Web browser tab.  

Kindle Previewer 

• Kindle Previewer  
The home page for Kindle Previewer provides Windows® and MacOS® installers. 

• KDP Tools and Resources  
Provides Windows® and MacOS® installers for Kindle Previewer, Kindle Comic Creator, 
Kindle Plugin for Adobe InDesign®, KindleGen (also Linux), and Kindle Reader. 

Kindle Publisher Tools 

• Kindle Publisher Tools  
Home page for their site.  

• Kindle Comic Creator  
Home page for this tool on the Kindle Publisher Tools site. 

• Kindle Plugin for Adobe InDesign®  
Home page for this tool on the Kindle Publisher Tools site.  

• KindleGen  
Home page for this tool on the Kindle Publisher Tools site. 

• Kindle Publishing Forum  
Threaded discussions of Kindle publishing tools  

KindleGen 

• KindleGen   
The home page for KindleGen provides Windows®, MacOS®, and Linux installers. 

• KDP Tools and Resources  
Provides KindleGen installers for Windows®, MacOS®, and Linux systems, and Windows® and 
MacOS® installers for Kindle Previewer, Kindle Comic Creator, Kindle Plugin for Adobe 
InDesign®, and Kindle Reader. 

• KindleGen Read-me  
Includes the procedures given here for converting e-books to Kindle format. Use KindleGen 
to convert source files in HTML, XHTML, or IDPF 2.0 format (.html  content files with an .opf 
XML manifest) into Kindle books in .mobi, .azw, or .prc format. 

• Amazon Kindle Publishing Guidelines  
Download these Guidelines and follow them to create the source files for Kindle e-books, and 
to publish Kindle e-books to the Amazon site. 

http://www.amazon.com/kindleformat/kindlepreviewer
https://kdp.amazon.com/self-publishing/help?topicId=A3IWA2TQYMZ5J6
http://www.amazon.com/kindleformat
http://www.amazon.com/kindleformat/kc2
http://www.amazon.com/kindleformat/kindlepluginforadobeindesign
http://www.amazon.com/kindleformat/kindlegen
http://www.amazon.com/forum/kindle%20publishing?_encoding=UTF8&cdForum=Fx21HB0U7MPK8XI
http://www.amazon.com/kindleformat/kindlegen
https://kdp.amazon.com/self-publishing/help?topicId=A3IWA2TQYMZ5J6
https://kindlegen.s3.amazonaws.com/Readme.txt
http://kindlegen.s3.amazonaws.com/AmazonKindlePublishingGuidelines.pdf
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Kindle Reading Apps 

• Download Free Kindle Reading Apps  
Provides Kindle Reader Apps for computers, tablets, smart phones, and the Web.  

• Kindle for PC  
Install Kindle Reader on a PC computer.  

• Kindle for Mac  
Install Kindle Reader on a Macintosh computer.  

• Help for Free Kindle Reading Apps  
Get online help for any Kindle Reader application.  

• Help for Other Kindle Apps  
Get online help for other Kindle applications.  

Kindle Direct Publishing 

• Kindle Direct Publishing  
Home page for their site.  

• Publishing FAQ  
Frequently Asked Questions on publishing your own e-books.  

• Kindle Direct Publishing Help  
KDP Help topics.  

• Types of Formats 
KDP help topic on book file formats that they can convert into Kindle e-books.  

• Basic HTML Formatting Guidelines  
KDP Help topic on preparing HTML files for conversion into Kindle e-books.  

• KDP Community Forums  
Public discussions on publishing your own e-books.  

• Building Your Book for Kindle  
Free book from Amazon. Available for PDF download and in print form.  

• “Professional Conversion Services”  
Lists commercial e-book conversion specialists. 

↑ Online Resources 

http://www.amazon.com/gp/kindle/kcp/ref=hp_201016410_download
http://www.amazon.com/gp/feature.html/ref=kcp_pc_mkt_lnd?docId=1000426311
http://www.amazon.com/gp/feature.html/ref=kcp_mac_mkt_lnd?docId=1000464931
http://www.amazon.com/gp/help/customer/display.html/ref=hp_200127470_kreadingapps?nodeId=200783640
http://www.amazon.com/gp/help/customer/display.html/ref=hp_200127470_kappsother?nodeId=201016410
http://kdp.amazon.com/
https://kdp.amazon.com/self-publishing/help?topicId=A36BYK5S7AJ2NQ
https://kdp.amazon.com/self-publishing/help
https://kdp.amazon.com/self-publishing/help?topicId=A2GF0UFHIYG9VQ
https://kdp.amazon.com/self-publishing/help?topicId=A1KSPVAI36UUC1
https://kdp.amazon.com/community/forumindex.jspa
https://kdp.amazon.com/self-publishing/help?topicId=A2MB3WT2D0PTNK
https://kdp.amazon.com/self-publishing/help?topicId=A2MB3WT2D0PTNK
http://www.amazon.com/dp/B007URVZJ6
file:///C:/Users/daviswd/Documents/hd_Docs/Kindle%20Previewer/_Docs/%22%09https:/kdp.amazon.com/self-publishing/help%3ftopicId=A3RRQXI478DDG7
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3.7 Release Notes and Known Issues 

3.7.1 Release Notes 

The Release Notes for all versions of Kindle Previewer are available online. To read them, click here.  

3.7.2 Known Issues for Kindle Previewer 

• In Kindle Previewer, blue characters display as black. On a Kindle device, blue characters 
display as light gray. 

• On MacOS® systems, when Device Mode is set to “Kindle for iPhone” or “Kindle for iPad,” 
cover images are displayed with a black background. 

• Image borders might not display correctly either in Kindle Previewer or on Kindle devices. 

• Nested tables, large tables, and table cells that contain text paragraphs or large images might 
not display properly either in Kindle Previewer or on Kindle devices.  

TIP:  Consider reformatting such tables. For guidance on tables, download the Amazon 
Kindle Publishing Guidelines (PDF). 

• In e-books with many images, Goto Location might not navigate to the desired location.  

• When the Devices menu is set to “Kindle e-ink” and you jump to new locations, HTML 
markup might be displayed. This does not indicate any problem with the page content. To 
refresh the display, click Previous Page then click Next Page. 

• When Device Mode is set to “Kindle for iPhone” or “Kindle for iPad” and you jump to new 
locations, tables might not display properly. To refresh the display, click Previous Page then 
click Next Page. 

• When Device Mode is set to “Kindle for iPhone” or “Kindle for iPad,” some options available 
in the iOS app (for example, changing the text color) are not available in Kindle Previewer. 

• When Device Mode is set to “Kindle for iPhone” or “Kindle for iPad,” the number of lines per 
page displayed in Kindle Previewer might not match exactly the number of lines displayed by 
the iOS app. 

• When Device Mode is set to “Kindle DX,” the number of lines per page displayed in Kindle 
Previewer might not match exactly the number of lines displayed on those devices. 

• When Device Mode is set to “Kindle for iPhone” or “Kindle for iPad,” the e-book’s Search 
menu is disabled. You cannot use it to search the book. 

• When Device Mode is set to “Kindle DX,” the e-book’s Device Location bar is disabled. You 
cannot use it to navigate the book. 

• On Windows® XP systems, the Auto Flip feature stops working if a screensaver runs while it is 
flipping pages, and Kindle Previewer goes into an unresponsive state. 

• On MacOS® systems, when multiple instances of Kindle Previewer run Auto Flip, Kindle 
Previewer sometimes goes into an unresponsive state. 

http://kindlepreviewer.s3.amazonaws.com/UG_ReleaseNotes_EN.txt
http://kindlegen.s3.amazonaws.com/AmazonKindlePublishingGuidelines.pdf
http://kindlegen.s3.amazonaws.com/AmazonKindlePublishingGuidelines.pdf

